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Orientation Symbols Used in the Manual  

 
To give the user a better orientation in the manual the following symbols are used: 

 
Warning Symbol 
 

 

The warning symbol points out critical moments  
you should pay attention to.  
This helps you to avoid problems during your work or to handle them. 

 
Tip Symbol 
 

 
 

The lamp symbol points out a tip  
that gives you praxis experiences  
to make your work easier. 

 
Note Symbol 
 

 
The hand symbol relates to notes,  
which you should pay attention to in order to assure  
that you can work without problems. 

 
Step Symbol 
 

 

 

The step symbol signals that a  
sequence of work operations  
is given. 

 
TRANSCAT PLM  in the Internet:  http://www.transcat-plm.com/ 

VDAFS in the Internet:  http://www.transcat-plm.com/tcsoft 

VDAFS  Hotline: 

 

Phone: +49 721 970 43   35 

E-mail: vdafs@transcat-plm.com 
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1. VDAFS Processor in General 

VDAFS PROCESSOR is a system-neutral CAD interface which permits the bi-directional 

interchange of 3-D geometries between CATIA and the VDAFS format.  

The conversion is possible in both directions—VDAFS PROCESSOR allows importing VDAFS 

formatted data into CATIA as well as exporting CATIA models to VDAFS standard. 

The conversion CATIA to VDAFS and vice versa enables the CAD-data exchange with other 

CAD systems, supporting the VDAFS standard. Thus the possibilities of CAD data ex-

change inside firms and between manufacturers and their subcontractors can be broad-

ened substantially. 

 
 VDA Standard 

The abbreviation VDAFS stands for VDA Flaechen-Schnittstelle—VDA Surface Interface, a 

standard CAD-data exchange format established by VDA, the German Association of the 

Automotive Industry. 

This standard has provided the answer to the difficulties resulting from the circumstance 

that different CAD systems use quite different mathematical methods to describe complex 

surface structures (which are met especially in the automobile design, e. g. in bodywork, 

coverings, seats etc.). As these complex surface structures can not be described by simple 

analytical formulae, in different CAD systems different methods of mathematical repre-

sentation were implemented. Consequently there arose the need in a neutral data format 

to transfer the design data between systems. The IGES 1.0 and 2.0 standards (Initial 

Graphics Exchange Specification), edited at the beginning of the 80’s, were not suffi-

cient enough so that the German Association of the Automotive Industry VDA elaborated 

the VDAFS 1.0 (1983) and VDAFS 2.0 (1987) standards for the exchange of surface data, 

which became German Standard DIN 66 301. 
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2. VDAFS PROCESSOR for CATIA V5 

The CAA-based VDAFS Processor for CATIA V5 supports VDAFS Version 2.0. It is used as 

interface between CATIA and VDAFS, allowing to convert CATIA CATProducts and CATParts 

into VDAFS files and VDAFS files into CATIA CATParts. Expanding on the VDAFS standard, 

VDAFS PROCESSOR can transfer not only points, curves, surfaces, but even topologies and 

bodies via the VDAFS TOP element.  

An outstanding feature is its full integration with CATIA V5. Converting CATIA V5 models to 

VDAFS format is possible by simply using the Save As item on the CATIA File menu. In the 

same way, VDAFS files can be opened as CATParts with the File > Open menu sequence. 

In addition to the interactive CATIA integration, the product also includes a graphic user 

interface (GUI) variant that can be started from within or outside of CATIA and a batch 

module for integration into automated processing applications. 

Main features of the VDAFS  PROCESSOR :  

 Full integration in CATIA V5 

 Available for all CATIA V5 platforms 

 Complete bodies can be imported/exported (not only their individual faces). 

 Possibility to define the scope of elements to be imported/exported, with several 
options 

 Different operating modes—from within CATIA or outside of CATIA, batch mode 

 Simplicity of operation 

 Multilingual user interface—English and German available depending on the language 
selected for the user interface. 

 

 
 

T I P :  

The language can be changed in common with the language for the CATIA 
user interface (CATIA menu bar item Tools > Customize—Options tab 
card – User Interface Language). 

The language of the dialog boxes (e. g. of the directory boxes) depends on 
the language setting of the operation system. 



A P P E N D I X :  2 . 1   V D A F S  P R O C E S S O R  U S E R  I N T E R F A C E S  A N D  O P E R A T I O N  M O D E S  

© TRANSCAT PLM GmbH 6 VDAFS PROCESSOR V1.10.x for CATIA V5 

2.1 VDAFS  PROCESSOR User Interfaces and 
Operation Modes 

To start VDAFS PROCESSOR four different operation modes can be used. The table 

below gives an overview of these modes. 

 
The details of the operation modes will be described in the following chapters. 

 

Operation mode 

How to be started Purpose and General description  
Detailed 
description  

 

 (1) Direct mode 

 CATIA menu bar item 
File > Save as 

 

 
 

    Purpose: 
Converting the current CATIA model 
 

 Source model is current CATIA model . 

 Before starting the conversion, set the conversion para-
meters in the Parameter Window which is opened after 
selecting the CATIA menu bar item 
Tools > Options menu 

 See chapter 
2.2 Direct 
operation mode 
on page 8. 

 CATIA menu bar item 
File   Open  

 

 

    Purpose: 
Importing one model from VDAFS format as the current 
CATIA CATPart.  
 

 Target model is a new CATPart. 

 See chapter 
2.2 Direct 
operation mode  
on page 8. 

 
Importing a CATPart into an opened CATPart is 
not possible with the direct mode—use for this 
task the dialog mode. 

 Before starting the conversion, define the conversion para-
meters in the Parameter Definition panel which is opened 
after selecting the CATIA menu bar item Tools > Options 
menu.  
 See sections 2.2.1 Setting the Transfer Parameters on 
page 9 (for general information) and 2.2.2 Parameter 
Dialog Panel on page 10 (for detailed information). 
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Operation mode 

How to be started Purpose and General description  
Detailed 
description  

 

 (2) Dialog mode, started from within CATIA 

 Toolbar icon 
 

 
 

    Purpose: 
Converting either the current CATIA-model into VDAFS 
format  
or a VDAFS-formatted model into the current CATIA 
CATPart. 

 See chapter 
2.2 Dialog 
operation mode 
on page 8. 

 
Importing a VDAFS file into an opened 
CATProduct is not possible. 
 

When the icon is clicked, a graphic user interface is opened 
that allows  

 to define the transfer direction; 

 to specify the output files; 

 to set the conversion parameters. 
 

(This mode is analog to the dialog mode, started CATIA-inde-
pendently, but in contrast to this latter it provides restrictions 
in the model selection.) 
 

 (3) Dialog mode, started CATIA-independently  

 Desktop icon  
 

 

    Purpose: 
Converting either one CATIA MODEL into the VDAFS 
format  
or one VDAFS-formatted model into a CATIA CATPart. 
 

When the icon is clicked, a graphic user interface is opened 
that allows  

 to define the transfer direction; 

 to specify the output files; 

 to set the conversion parameters. 
 

(This mode is analog to the dialog mode, started from within 
CATIA. This latter, however, is restricted in the model selec-
tion.) 
 

 See chapter 
2.2 Dialog 
operation mode 
on page 8. 

 

 (4) Batch mode 

 Command at the 
prompt in the 
command line 

    Purpose: 
Converting from outside of CATIA with integration into 
automated processing applications, possibility to 
process several jobs one after another.  

 Before starting the batch conversion run, the parameters  
for the batch jobs must be set in the vdafs.in file  
(used as input file). 

 See chapter 
2.4 Batch Mode 
on page  
PAGEREF 
_Ref34820700 
\h 36. 
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2.2 Direct Operation Mode 

The direct mode is used from within CATIA menu:  

 when the current model is to be exported to the VDAFS format, 

 or when a VDAFS file is to be imported to become the current CATPart. 

 

 

S T E P S :  

(1) Predefine parameters. 

(2) Select file name and start conversion. 

 

 See chapter 2.2.1. 

 See chapter 2.2.4. 

 

 

T I P :  

If you want to export an other than the current CATIA model file  
or import a model file not as current CATPart,  
use the Dialog operation mode (see page 29)  
or the Batch Mode (see page 36). 

 
In the Direct Operation mode the conversation can be started directly, simply by defining 

one only file name:  

 When importing from VDAFS into CATIA:  
specify source model file name  
(the target file name will be the same, but with the CATPart extension added). 

 When exporting from CATIA to VDAFS):  
specify the target model file name  
(the source model file being the current CATPart). 

 

 
Precondition for starting the direct mode is that the parameters must have 

been predefined (see the following chapter). 
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2.2.1 Setting the Transfer Parameters  

 

 
S T E P S :   

 Select CATIA menu bar item 
Tools > Options. 
 The Options dialog panel will be 
opened. 

 

 

 

     
 In the Options dialog panel in the 

tree on the left side select the 
Compatibility item. 

 Select the VDAFS tab card. 

(This tab of the tab card may be not visible, 
because it is situated on the right—click the Move 
to the Right button). 
 

 On the VDAFS tab card you can: 

 

 define conversion parameters that 
will be used for conversion, but are 
not saved in a profile, 

 or select an existing conversion 
profile, 

 
 

 

 or modify the parameters of an existing profile,  

  or create a new profile.  
 

  Here also the name and the directory of the log fi le  can be selected, or name 
and directory for a new log file can be specified.  

 

The elements of the VDAFS tab card will be described in the chapter 2.2.2 Parameter 
Dialog Panel on page 10. 

How to use profiles will be described in the Conversion Profiles chapter on page 24. 
 

 When the parameter setting is completed, press the OK button. 

 If you want to discard the parameter settings of the current session, press the 
Cancel button. 
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T I P :   

If you have defined conversion parameters without saving them in 
a profile, and you close the options window with the OK button, 
the conversion parameters will be saved in the CATSettings of 
CATIA. When opening again this window, you will find these last 
settings maintained. 

The parameter settings in the present options window and the 
parameter settings in the conversion dialog window are stored 
independently of each other so that in the windows of these 
different conversion modes different parameters can be kept. 
 
 

 

 
NOTE:  

If the Options window is closed by pressing the Cancel button, 
the parameter settings of the current session will be discarded. 

(This behavior of the Cancel button is different from that of the Cancel 
button in the VDAFS parameters window—see there.) 

 

 
2.2.2 Parameter Dialog Panel 

 Parameter Dialog Panel—General Elements  
 



 








    

   
 




Profile bar 
Report bar 
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   Path buttons 


 

OFF position: The path is not shown in the text box. 

 
ON position: The path is shown in the text box. 

 
 Open folder dialog box buttons  

When this button is pressed, the directory window is opened,  
where you can select files. 

  

 
 Save Profile button  

When this button is pressed, the profile will be saved. 
 

 Conversion Direction tab cards 

Two conversion direction are possible:  

 from CATIA to VDAFS (a CATIA CATPart will be converted into a VDAFS model file);  

 from VDAFS to CATIA (a VDAFS model file will be converted into a CATIA CATPart or 
imported into the current CATPart). 

Depending on the Selected Conversion Direction tab card selected (VDAFS to 
CATIA or CATIA to VDAFS), different Parameter Groups tab cards  will be 
available. 

 Parameter Groups tab cards 

For the CATIA to VDAFS direction, the available tab cards are: 

 Elements 

 Options 

 Header 

For the VDAFS to CATIA direction, a Header tab card is not available, as in this case 
no header is created.  
 

  OK button 

If this button is clicked, the specified conversion parameters will be 
saved in CATIA, the dialog panel will be closed. 

  
Cancel button 

If the dialog panel is closed by pressing this button, the parameter 
settings of the current session will be discarded. 
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 Parameter Dialog Panel—CATIA to VDAFS—Elements 
 



 














 
 Element selection box 

By choosing one of the element selection methods it can be selected what is to be 
exported: 

  Multi-selection 
It will be exported all  what is 
contained in the respective pro-
duct/part. For this option the 
multi-selection is active allowing 
to specify/restrict the number 
and the types of elements to be 
exported.  
This means: 

 
 

 (1) The element selection in the specification tree is not taken in account; it will be 
exported all elements—both highlighted and not highlighted elements. 

 (2) The restrictions for the export, specified in the Element selection, Geometry 
and in the Structure boxes, will be taken in account. 

 

active 

  
a

ll
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  Only selected: 
It will be exported only the ele-
ments that are highlighted in the 
specification tree, multi-selection 
is not possible (i. e. the Element 
selection, Geometry and Struc-
ture boxes are deactivated). 

 
 


 

NOTE 

If in the specification tree no elements are highlighted, nothing will be 
exported. 
 

  Only selected with multi -
selection for Parts:  
It will be exported only the items 
that are selected in the specifica-
tion tree (the selected elements 
of parts and, in case of products, 
the selected part components 
and elements of parts). For this 
option the multi-selection is 
active (see above). 

 
 


 

 

NOTE 

The Only selected with multi-selection for Parts option is active only 
for Products. 

 
 Multi selection box 

 Radio buttons for elements with hidden and show state  

With these radio buttons, it can be selected whether the export is to be restricted 
depending on the visibility state of the elements: 

  Show + NoShow:  Both visible and invisible elements will be exported. 

  Show:  Only visible elements will be exported. 

  Show + Visible:  It will be exported only visible elements that are really visible 
(i. e. that have no invisible parents). 

active 
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 If the Show export option is selected, the elements with Show attribute, that are 
inside OpenBodies with the NowShow (hidden) attribute, will be put in a VDAFS 
SET element with the name NOSET. (i. e. one NOSET element for al l  elements). 

 Only Elements without Children check box 

If this option is activated, only elements will be exported that have no child 
elements.  
If this option is deactivated, all  elements will be exported—elements having child 
elements as well as elements having no child elements. 

 On Layer check box with text box 

If this option is deactivated, the elements of all  layers will be exported as well as 
elements that are not situated on a layer. 

If this option is activated, by entering layer numbers it can be specified elements 
of which layers are to be exported. 

The layer number must be specified comma separated; layer ranges can be specified 
by their first and last number, separated by hyphen. 

Defining layer ranges: 

 n-m All layers from n to m  

 -n All layers from 1 to m  

 n- All layers from n to the last layer 

 Example: 1, 3-10—There will be exported the layers 1 and 3-10. 

 To include in the export elements that are on no layer, specify the number 1000. 

 




Geometry and Structure boxes 

 
 

Elements 

If the option box of an element 
is activated, the respective 
element will be imported into 
CATIA. 

 
 

Options 

For some elements, import options are 
available. The options will be active 
only, if the respective element is selec-
ted for import.  
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  Geometric elements 

 Element Options Description 
  

  Point –  

  Line –  

  Circle 
CIRCLE  
CURVE Circle is converted into VDAFS element CURVE (approximated curve). 

  Curve –  

  Sketch –  

  Plane – Plane is converted into a surface 

  Reference plane –  

  Surface 

 Solid 

 TOP / 
FACES 

SURFACES/SOLIDS are converted into the VDAFS element TOP or 
FACE (i. e. faces with topological information or individual faces). 

 

  Structure elements 

 Element Options Description 
  

  Body 

 Layer  

GROUP Either layers or bodies can be exported into GROUPS.  

  Body 

 Layer 

 Part  

SET Either layers or bodies or CATParts can be exported into SETS. 

  

 
 

 

When exporting both structure elements BODIES and LAYERS, the transferal can be 
only alternatively:  

 either  LAYERS to SETS   and BODIES to GROUPS 

 or   LAYERS to GROUPS  and BODIES to SETS. 
It is neither possible to transfer both SETS and GROUPS to LAYERS nor to transfer 
both to BODIES. 
 

 Axis systems – Axis systems are converted into VDAFS element TRANSFORMATION 
MATRIX (TMAT). 
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 Parameter Dialog Panel—CATIA to VDAFS—Options 
 



 















 

 Abort on Errors check box 

If this check box is activated, the conversion will be aborted in case of an error. 

 Identifier radio buttons 

Select one of the options:  

 No comment 
The CATIA-feature-name will not be written as comment in the VDAFS file. 

 Comment 
The VDA name and the CATIA feature name will be written as comment in the 
VDAFS file. 
Example for the notification: 
$$ VDAFS-NAME "SURF0006" WAS CREATED FOR CATIA-ELEMENT                  00000260 

$$ " Solid Surface.1"                                                   00000270 

In case of re-export, the notification would be as follows: 
nameVdaEntity(nameExportedV5Feature) 

Example: SURF0006(Solid Surface.1) 
 

 Axis system for CATParts documents radio buttons 

Depending on the selected option, the geometry will be exported in relation to the 
global axis system or to the current local axis system. 
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 Approximation Deviation check box with text box 

If this check box is activated, an approximation deviation can be specified. 

Default: 0.0001  
 

 
NOTE:  

The smaller the approximation deviation is,  
the longer the computing time will be. 

An other than the default value should be used only in 
case that problems occur. 
 

 

 Export Product radio buttons 

Dependent on the selected option, a CATProduct will be exported 

 either into one VDAFS file 

 or into several VDAFS files—every component is exported into an individual 
VDAFS file. 

In both cases the geometry will be positioned relative to the global axis system of the 
CATProduct. 

To be able to distinguish the VDAFS files when exporting several components into 
several VDAFS files, to the file names there are appended number suffixes.  
(xxxxx—serial number, consisting of five figures and starting with 00001.)  
In this case the name of the VDAFS files contains the follow components: 

VDAFS-output-filename_CATPart-filename_xxxxx 

(As CATPart file name the name of the referenced part will be used.) 

 Export wire—Only CURVE if curve on surface option 

This option must be activated if it is intended to export wire geometry only as curve 
(i. e. without underlying surface). 

 Export surface—Use total limits for base surfaces option 

This option must be activated when exporting curves and surfaces together if it is 
intended to export the complete surface (and not only the segments that are covered 
by the curve). 


 

 
NOTE 

As a result of activating this option the size of a VDAFS file may increase 
considerably. 
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 Parameter Dialog Panel—CATIA to VDAFS—Header 
 



 



 

 Receiver / Sender / Project text boxes 

Enter the required information in the text boxes.  

According to the VDFAS prescriptions, the following information is mandatory: 

  VDAFS version number,  

 name of the sender company,  

 contact person,  

 telephone number, 

 address,  

 date of creation,  

 project name,  

  object description number. 
 

 However, VDAFS PROCESSOR does not check whether these boxes are filled out or not. 
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 Parameter Dialog Panel—VDAFS  to CATIA—Elements 
 



 





 

 Elements 

If the option box of an element is activated, the respective element will be imported 
into CATIA. 

 Options 

For some elements, import options are available. The options will be active only, 
when the respective element is selected for import.  

 Color 

With this list box, to geometric elements a color can be assigned.  
 

 

 Geometric elements 
 

 Element Full Name Options Description 

  POINT Point –  

 PSET Point Set  Points Point sets are exported as points. 

 Polygon Points are catenated to polygons. 

 Line The points of the set are transformed to 
several individual lines. 

 Spline The points of the set are transformed into a 
spline, calculated by interpolation. 

 
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 Element Full Name Options Description 

 MDI Master Dimension 
(Point Vector 
Sequence) 

 Points Points with vectors are exported as points. 

 Points+Line Points with vectors are exported as points 
with line. 

 Line Points with vectors are exported as lines. 

 Polygon Points with vectors are transformed into 
polygons. 

 Spline Points with vectors are transformed into 
splines. 

 Spline+Tangent Points with vectors are transformed into 
splines with tangents. 

 CIRCLE Circle or circular arc –  

 CURVE Curve  Line, if Degree 1 When this option is activated, curves with 
polynomial degree 1 are transformed into 
lines. 

 SURF Surface –  

 CONS Curve on surface –  

 FACE Face –  

  TOP Topology   Solid if closed  Depending on which of these options is 
selected, c losed topologies will be exported 
in form of solids or surfaces. Open topo-
logies in every will be exported as surfaces 
irrespective of the selected option. 

  Surface if closed  

 

 Structure elements 

 Element Options Description 

  Set 

 Group 
 Layer  

Body 
Set/Groups will be transferred to layers or bodies. When transfer-
ring to layers, the layers will be numbered consecutively, starting 
from 0. When transferring on bodies, the bodies will be named 
with the set/group names. 

   

 

 

When exporting both structure elements SETS and GROUPS, the transferal 
can be only alternatively:  

 either SETS to LAYERS and GROUPS to BODIES 

 or SETS to BODIES and GROUPS to LAYERS. 
It is neither possible to transfer BOTH sets and GROUPS to layers nor to 
transfer BOTH on BODIES. 
 

  TMat Transformation Matrix 
 

The VDAFS Transformation Matrix (TMAT) will be converted into 
an axis system. 

  TList Transformation List Planned 
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 Parameter Dialog Panel—VDAFS  to CATIA—Options 
 



 

 








 



 

 
 Abort on Errors check box 

If this check box is activated, the conversion will be aborted in case of an error. 
 

 Create Parents check box 

If this check box is activated, in the CATIA specification tree, parent elements will be 
created: 

 For the FACE element SURF and CONS parent elements will be created. 

 For the TOP element FACE parent elements will be created. 

 For the CONS element CURVE parent elements will be created. 
 

From every VDAFS SET an Open Body is generated, the elements of the SET being in-
cluded in this body. If the SET contains TOP elements, representing a solid, for each 
of them an individual body is generated. 

In the list box, there is the choice between two alternatives: 

 in any case: 
Parents will be created for all  elements —not recommended, as it is to time 
consuming, and unnecessary elements will be created; 

  i f  error:  
Parent elements will be created only in case of error (in this case, a message will be 
edited and an entry will be made in the log file). 

  
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  

If the check box is deactivated, no parent elements will be created. 
 

 Create Parent Elements as Feature check box 

If this check box is activated, parent elements are created as feature in the CATIA 
specification tree. 
 

 Identifier radio buttons 

 If the Use VDAFS Identifier radio button is selected, the VDAFS identifier is 
used to name the CATIA feature. 

 If the New Identifier radio button is activated, CATIA default identifiers are 
used. 

 

 Axis System radio buttons 

Not yet implemented. 
 

 Connect segments to individual element control tools 

 Elements option buttons 

Selecting or not selecting the different element options defines how the segments of 
the respective elements (curves, curves on surface, surfaces) will be imported. 
 

 When an option is selected, the 
element will be imported by merging 
its segments into individual elements. 
 

When the options are not selected, the 
element will be imported as a topology 
consisting of several pieces (faces in case 
of SURF, curves in case CURVE or CONS) 
each piece representing one segment. 



    
 

 Example: 
result of the import by merging, consisting of 
uni f ied segment of surface and curve 

 Example: 
surface and curve, imported by breaking , i. e. as 
one topology consisting of several pieces 
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N O T E :  

The converting mode by breaking into segments needs more time than 
merging segments do single elements. 

 
 Continuity condition l ist box 

Here a continuity condition can be selected. 

Elements that fulfi l l  the selected condition will be imported using merging mode. 

Elements that do not fulfill the selected condition will be imported, using breaking mode. 


 

NOTE 

Even though VDAFS PROCESSOR offers the option of using several continuity 
conditions (or no continuity condition at all) for the merge-mode imports, we 
strongly advise against using any but the C2 continuity  condition—C2 
continuity is the only one that we can recommend. 

The use of other continuity conditions can have unpredictable results for the 
usability of the imported elements. 

VDAFS PROCESSOR provides the administrator the facility to lock the selection of 
the continuity conditions  and the tolerance  so that the user can work only 
with the values preset by the administrator. 

 Control points tolerance text box 

Specify here the desired tolerance. 
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2.2.3 Conversion Profiles  

 

What is a Conversion Profile? 

A conversion profile is the set of specifications about on  

 what elements of a model file are to be converted,  

 values for the options of a conversion. 
 

The profile is saved in a text file with the "tcp" extension. For export from CATIA to VDAFS, 

the conversion profile can also contain information about sender, recipient and project.  

The advantage of saved profiles is that for different export or import tasks, which are to be 

done more or less frequently, the settings can be predefined and stored in such profiles. 

The export or import can then be started speedily, after selecting the required profile 

instead of setting all parameters again.  

 
Selecting a Profile 

 

 S T E P S :  

(1) Press the Open Directory Window button . 

(2) Select in the Directory window the required profile  
(a file with “.tcp” extension) 

(3) Press the OK button . 
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Modifying an Existing Profile  

 

 S T E P S :  

(1) Press the Open Directory Window button . 

(2) Select in the Directory window the profile that you want to modify 
(a file with “.tcp” extension). 

(3) Select the conversion direction that you want to define with the VDAFS 
to CATIA and CATIA to VDAFS tab cards. 

(4) Change the parameters on the Element, Option and Header tab 
cards. (Details of this tab cards are described in the chapter  REF 
_Ref35397804 \r \h 2.2.2 Parameter Dialog Panel on page 10 et sqq.). 

(5) If you press the Save button on the right side of the Profile bar , the 
old parameter settings will be overwritten with the new settings.  

(6) Press the OK button  to close the Options Dialog panel. 

 

Creating a New Profile 

 

 S T E P S :  

(1) Press the Open Directory Window button . 

(2) Select in the Directory window a profile that you want to use as the 
base for the new profile (a file with tcp extension). 

(3) Select the conversion direction that you want to define with the VDAFS 
to CATIA and CATIA to VDAFS tab cards. 

(4) Change the parameters on the Element, Option and Header tab 
cards.  
(Details of this tab cards are described in the chapter  REF 
_Ref35397804 \r \h 2.2.2 Parameter Dialog Panel on page 10 et sqq.). 

(5) Type a new name in the Name list box on the Profile bar . 

(6) When you press the Save button on the right side of the Profile bar , 
the new profile will be saved.  

(7) Press the OK button  to close the Options Dialog panel. 
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T I P :  

Check profiles always are conversion direction specif ic,  
i. e. a given profile is either a CATIA-to-VDAFS import profile or a VDAFS-to-
CATIA export profile.  

In dialog operation mode, the conversion direction is defined automatically, 
depending on the Parameter window opened:  

 If you have opened the CATIA-to-VDAFS parameter window and  
save your profile, VDAFS PROCESSOR sets the argument of the 
*DIRECTION_TO parameter on “VDAFS”. 

 If you have opened the VDAFS to-CATIA-parameter window and you 
save your profile, VDAFS PROCESSOR sets the argument of the 
*DIRECTION_TO parameter on “CATIA”. 

Though the profile contains all parameter for both conversion directions, for 
processing are taken in account only the parameters of the stated conver-
sion direction.  

For example, if the *DIRECTION_TO parameter is set on “CATIA”, only 
the *VC_ parameters are taken in account (i. e. the parameters for the 
VDAFS to-CATIA direction). 
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2.2.4 Starting Conversion 

 CATIA-to-VDAFS Export  
 

(1) Select CATIA menu bar item is  
File > Save as. 

 

 

 
 

(2) In the Save As dialog panel, 
select the vda model file type. 

(3) Press the Save button. 

 

 
 

(4) Select in the Element Selection 
dialog box the required option.  

(The functions of these options are the same as 
those of the options in the Element selection 
box—see there on page 12. 
Displaying this dialog box can be deactivated 
using the CATIA option settings under Options > 
General > Compatibility > VDAFS tab card > 
No dialog for Save As/Open option.) 
 

(5) Press the Save button. 

 The export will be started. 
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 VDAFS-to-CATIA Import  
 

(1) Select CATIA menu bar item 
File > Open  

 

  

 
 

(2) In the Directory window open the 
required directory. 

(3) In the File Type list box, select 
*.vda type. Then select the file of the 
vda type with the model to be 
imported. 

(4) Click the Open button. 
The VDAFS file will be imported into 
the current CATPart. 

After completing the import operation a dialog box 
is opened asking whether the user wants the log 
file get opened.  
Displaying this dialog box can be deactivated 
using the CATIA option settings under Options > 
General > Compatibility > VDAFS tab card > 
No dialog for Save As/Open option. 
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2.3 Dialog Operation Mode  

This mode can be started in two ways: 

 CATIA-independently 
(outside of CATIA) 
using VDAFS desktop 
icon 

 

Export:  One arbitrary CATPart  or CATProduct 
can be exported. 

Import:  One arbitrary VDAFS fi le can be 
imported under an arbitrary name. 

 from within CATIA 
using VDAFS toolbar 
icon  

The import and export are restricted as follows. 

 Export:  The current model CATPart or 
CATProduct) can be exported  

 Import:  A VDAFS fi le is imported into an 
(empty or not empty) activated CATPart. 

  
 

Importing a VDAFS file into an opened 
CATProduct is not possible. 

 
Though the aspect of the user interfaces differs between the VDAFS PROCESSOR window 
for the dialog conversion started from within CATIA and that one, which is started CATIA-
independently, but the offered functions are the same (besides of the above mentioned 
import/export restriction). 

 

 
NOTE:  

The VDAFS toolbar inside CATIA is available only:  

 if a CATPart or a CATProduct is opened. 

 and if the VDAFS toolbar is activated. 

(The VDAFS toolbar can be activated in the same way as 
all the other CATIA toolbars are activated.) 

 

 

 

 S T E P S :  

 (1) Start the user interface  See above.  

 (2) Select the transfer direction.  See chapter 2.3.1 Selecting the 
Transfer Direction on page 30. 

(3) Set the transfer parameters.  See chapter 2.3.2 Setting the Transfer 
Parameters on page 31. 

(4) Start the transfer operation. See chapter 2.3.3 Starting Conversion 
on page 35. 
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2.3.1 Selecting the Transfer Direction  

 









 

 CATIA-to-VDAFS button  

Press this button, if you want to convert a CATIA part into a VDAFS file. 

 VDAFS-to-CATIA button  

Press this button, if you want to convert a VDAFS file into a CATIA part. 

 Exit Button 

Press this button if you want to abort VDAFS PROCESSOR. 

 

  

TIP: 
In the Parameter Window, you can verify the transfer direction selected by means of the 
Conversion Direction Symbol on the left side of the window’s bottom (see General Tab 
Card on page 31). 
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2.3.2 Setting the Transfer Parameters   

 Parameter Window—General Tab Card 
 



 



 

 

 

 
 








      

     
 
The general tab card is identical  for both conversion directions–CATIA to VDAFS and 

VDAFS to CATIA. The only difference is the sequence of the CATPART file text box and 

the VDAFS file text box, which corresponds always to the conversion direction. 

 

Standard Elements 

 Tab Cards 

In the tab cards you can find parameter groups. When opening the parameter 
definition window, the General tab card is preselected. 

 Path buttons 

 
OFF-position: The path is not shown in the file name text box. 

 
ON-position: The path is shown in the file name text box. 

 






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 Open Directory Window buttons 

 
When this button is pressed, the directory window is opened, where you can 
select a file. 

If the Identical Names check box is activated, after pressing this button, in 
the directory window the selection of catalogs only is accessible, the file 
name selection is blocked. 
 

 Save File button 

 
When this button is pressed, the file will be saved. 

  

 Conversion Direction Symbol  

Here is shown, whether the Parameter Window for the CATIA-to-VDAFS direction is 
opened or that for the VDAFS-to-CATIA direction. 

 Start button 

When this button is pressed, the conversion will be processed. 

 Cancel button 

When this button is pressed, the Parameter Window will be closed.  
 

 

T I P :   

If you have defined conversion parameters without saving them in a profile, 
and you close the parameters dialog window with the Cancel button or with 
Close button (windows element) the conversion parameters will be saved 
in the CATSettings of CATIA. When opening again this window, you will find 
these last settings maintained.  
 

(This behavior of the Cancel button is different from that of Cancel button in the VDAFS 
Options window—see there.) 

The parameter settings in the present parameter dialog window and the 
parameter settings in the options window are stored independently of 
each other so that in the windows of these different conversion modes 
different parameters can be kept. 

 

 Help button 

When this button is clicked, a PDF file is opened containing the VDAFS PROCESSOR 
manual. 

PRECONDITION:  

On your computer ADOBE ACROBAT READER must be installed (version 4.0 or higher) 
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Specific Elements 

 Document environment for Catia file radio button 
With these radio buttons, you can select the way in which the CATIA files are selected: 

 File/Folder:  The files are selected in a file selection dialog box by means of 
folders. 

 Logical File System / DL Name:  Instead of folders in a selection dialog box 
for selection the DL names are offered which the user has defined for the paths. 
(For details see CATIA help). 

 


 

NOTE: 

This selection is available only in the dialog box of the CATIA-
independent dialog mode and allows to select CATIA files only. 

 
 

 

 
 When the Logical File System / DL-Name option is activated, after pressing the 

Open folder dialog box button, (instead of the usual file selection dialog box) the 
following dialog box is opened that allows to select files by means of DL names. 
 

 

 

 

  

   

     
  DL name list box 

Select here a DL name. As soon as a DL name has been selected, in the File list 
box  the names of the files will be shown that are available in the respective 
folder. 

  File l ist box 

Select here a CATIA file. 

  File name text box 

In this text box, the name of the selected file is shown. When the Open button 
is pressed, this file name will be adopted. 
 

 
 

NOTE: 

If in case of the VDAFSCATIA conversion direction the Identical 
names option  is activated, in the DL-name selection dialog box 
only a folder can be selected, but not a name. 

 

 Profile text box 
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In this text box, the conversion profile selected in the directories is shown. You can 
also enter a new profile name to save a profile under a new name.  

To get detailed information about the use of profiles see chapter 2.2.3 Conversion 
Profiles on page 24. 
 

Input and Output File Name text boxes 

The upper of these two text boxes is the input (source) file text box,  
the lower–the output (target) file text box.  

 The order of the VDAFS and the CATIA file names corresponds with the conversion 
direction; when the VDAFS-to-CATIA conversion direction is selected, the order of the 
VDAFS file text box  and the CATIA file text box  in comparison with the 
screenshot above is inverted. 

 In both text boxes, file names can be typed or selected in the directories. (The CATIA 
file name has the extension CATPart; the name of the VDAFS file—the extension 
.vda.) 

Note:  
If the dialog conversion mode has been started from within CATIA (by clicking on the 
toolbar icon), the CATPart file selection is inactivated. Thus, when exporting from 
CATIA to VDAFS, only the current CATPart can be exported. When importing from 
VDAFS to CATIA, the imported model will be added to the current CATPart. 
 

 Log file text box 

In this text box, the log file name is shown. The log file name can be selected in the 
directories or can be typed (this can be the name of an existing log file, which will be 
overwritten, or a new name). 
 

 Identical Names check box 

If it is desired to give to the output file and the log file the name identical with the 
input file name, activate this check box. The file name extensions are added 
automatically. 
 

 Replace check box 

If this check box is activated, an existing CATIA or VDAFS file with the same name as 
the CATIA or VDAFS file to be created will be overwritten. 
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 Execution radio buttons 

With these radio buttons, you can select at what time the conversion job is to be 
started: 

 Execute now radio button 
The conversion job will be started immediately after clicking the start button.  

 Execute at … radio button 
(The “Execute at” feature is not yet implemented). 
Save as Job radio button. 
If this option is selected, in the text box a job file name can be typed (extension 
“.job”) or an existing job file can be selected in the directories. To save the 
settings in the specified job file, the Start button must be pressed.  
The job files are destined to be used as input files for batch operations. Job files are 
similar to conversion profiles, but contain in addition to the conversion parameters 
also the file names required for a job.  

 
 Parameter Window—Other Tab Cards 
 

The content of the other tab cards, i. e. the Elements, Options and Header tab cards for 

the CATIA-to-VDAFS conversion direction, and the Elements and Options tab cards for 

the VDAFS-to-CATIA conversion direction, is identical with the content of the tab cards in 

the Direct Operation mode, described above. For the detailed description of the tab cards 

see chapter 2.2.2 Parameter Dialog Panel on page 10 et sqq. 

 
2.3.3 Starting Conversion 

The conversion will be started by clicking on the Start button on the Parameter window. 

The execution time depends on the Execution setting (see Execution radio buttons on 

page 35).  
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2.4 Batch Mode 

In the batch mode, VDAFS PROCESSOR is started without graphic user interface.  

To start the batch run, the batch command is to be typed in the UNIX or WINDOWS com-

mand line. (Alternatively, the batch command can be written in a batch file, e. g. *.bat, or 

can be linked at an icon.) 

The batch mode offers the following advantages: 

 The VDAFS conversion can be integrated into company-own environments. 

 Several conversion jobs can be processed one after another, no user interactions and 
no-restart being necessary.  

 The VDAFS processing can also be started at a predefined time (using UNIX-com-
mand “at” or WINDOWs Scheduler). 

 
Command: 
 
 

TCAVdaBatch –env <name> -direnv <dir> -b[ -in <job>][ -out <log>] 
 

or 
 

TCAVdaPureBatch –env <name> -direnv <dir> -b[ -in <job>][ -out <log>] 
 

 
The TCAVdaPureBatch command is to be entered when working on a computer with a 
display that is not a graphic display. 
 

Option/argument Explication 
 

–env <name> Name of the CATIA environment  
for VDAFS run  

-direnv <dir> Directory of the aforementioned CATIA environment  

-b Parameter, calling VDAFS PROCESSOR without graphical user interface  

-in <job> VDAFS job file (default: vdafs.in in current directory) 

-out <log> Processor log file (default: vdafs.out in current directory) 
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2.5 Log Files 

Every conversion job is reported in a log file (having the .log name extension). The log 

file language (English or German) is determined by the CATIA language setting (for details 

see the language setting paragraph on page 5). For each of the conversion directions—

VDAFSCATIA and CATIAVDAFS—separate log files are created. The log file contains: 

 the parameter setting, used for the conversion job, 

 the VDAFS header section 

 the listing of the elements transferred and possibly not transferred, and 

 possibly a listing of the errors that arose in the conversion job. 

 

 
NOTE:  

For the log file generally a file name must be specified. If no 
name has been specified, no log file can be generated, the 
operation system will edit an error message. 

 

 

 

T I P :  

To get a correct representation of the log file, the font selected should be a 
monospace font (e. g. Courier, CourierNew). 
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Elements of the Log Files – Export to VDFAS 
  

 

Title 

Parameter Section 

 

VDAFS Header Section 

 

Warning message  
(edited if the need arises)  

 

Names of the exported 
CATParts, if need be with 
error report  
(Here: example for the 
export of a CATProduct) 
Return code:  
0—OK 
4;8;16—errors. 
Here the highest error of 
all found errors is 
displayed.) 

 

Element Summary 
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Elements of the Log Files – Import from VDFAS 
 

 

Title  

Parameter Section 

 

VDAFS Header Section 
(the data is taken from 
the imported VDAFS file) 

 

(These example log file does 
not contain a warning 
message.)  

Number of segments 
connected/not connected 
to individual elements 

 

Element Summary 
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2.6 Conversion Errors 

In case that errors occur, error messages are displayed—as far as possible at an early 

stage—in order to help the user to prevent early enough the emergence of errors. 

For the following errors for technical reasons no error messages can be displayed; they are 

stated only in the conversion report. 

 

Error 
When the 
error occurs? 

Reason Elimination 
 

A component not 
has been exported 

When exporting 
CATProducts to 
VDAFS 

A component is not loaded and 
not visible. 

Load the component. 

Broken link—the component is 
not in the directory which is 
indicated in the reference link. 

Reestablish the link 
(consistence between the 
location of the component and 
the link). 

 

 

 

T I P :  

To make the error elimination easier, the following tools can be used: 

 CATIA function “Desk” (menu bar item File > Desk ) 

 Preventive checking (before converting) of the CATProduct with the 
TRANSCAT checking tool Q-CHECKER—criterion “Product Component with 
Broken Link to Part/Product”. 
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3. Appendix 

3.1 Description of VDAFS Database 

VDAFS Files consist of lines, each with 80 characters. The columns 73–80 of each line con-

tain an increasing, but not necessarily continuous sequence number. Leading numeration 

spaces are zero filled. 

The file contains geometrical elements and non-geometrical elements (header, comments, 

structural elements, transformation data, trailer). 

The first text lines (at least 20) of a VDFAS-file contain the header, used to identify the file 

automatically. These lines must at least contain the following information: 

 

VDAFS Version (at present 1.0 or 2.0) 

Company (Sending) 

Name (Sending) 

Phone 

Address 

Creation Date 

Project 

Object Code 

Company (Receiving) 

Name/Department (Receiving) 
 

 
The next section of the VDAFS file contains the description of the geometrical elements 

following an exact syntax. 

The non-geometrical element group of elements GROUP is provided to combine several 

elements in order to form a group.  

Comment lines can be inserted as many as required. 

The VDAFS file is closed by the trailer, standing as the last line of the file. 
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3.2 Syntax of VDAFS Format 

Element description: The description of all elements starts with the element name 

(max. 8 characters), followed by an equals sign and the element type: 

 

 name = <elementtype>/[parameter, parameter, … parameter] 
 

 
Element names: The element names may be written only in capital letters (A to Z) or 

digits (0 to 9). The first character of a name must be a letter.  

Parameters:  If an element has more than one parameter, the parameters are comma 

separated. Depending on the element definition, parameters can be written either as inte-

ger or as real numbers. If the number is a real number, the decimal point (.) always must 

be stated. If the decimal point is not stated, an error will occur because the parameter will 

be interpreted as integer. The whole parameter set of an element can take several lines. An 

individual parameter is to be started in a new line. Logically the parameter separator is 

considered as belonging to the number.  

In the following, there will be given an overview of the geometrical elements, defined by 

the VDAFS exchange format (version 2.1). 
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Example VDAFS file  
 

TCVDAFS  = HEADER / 20                                                  00000010 

************************************************************************00000020 

VDAFS VERSION .... :  2.0                                               00000030 

---------------------SENDER-DETAILS-------------------------------------00000040 

SENDER COMPANY ... : TRANSCAT  KARLSRUHE                                00000050 

CONTACT NAME ..... : J. KRAUT                                           00000060 

CONTACT PHONE .... : +49 721 9123 0                                     00000070 

CONTACT ADDRESS .. : STREET+NUMBER                                      00000080 

PRODUCING SYSTEM . :  / TRANSCAT VDAFS 0.0.2                            00000090 

PRODUCING DATE ... : 2003.03.21                                         00000100 

SEND FILENAME .... : C:\DOKUMENTE UND EINSTELLUNGEN\RJUNGHAN\EIGENE DATE00000110 

---------------------PART-DETAILS---------------------------------------00000120 

PROJECT .......... : THIS                                               00000130 

OBJECT ID ........ : 0815                                               00000140 

VERSION .......... : 4711                                               00000150 

CONFIDENTIALITY .. : NO                                                 00000160 

VALIDITY DATE .... : 2004-01-01                                         00000170 

---------------------RECEIVER-DETAILS-----------------------------------00000180 

RECIEVER COMPANY . : TRANSCAT NA                                        00000190 

REC. NAME/DPARTMENT: U. SAM                                             00000200 

************************************************************************00000210 

$$ Layer nr 1000                                                        00000220 

SET00000 = BEGINSET                                                     00000230 

$$  Solid Surface.1                                                     00000240 

SURF0000 = SURF / 1,1,-3.440000000E+00,+3.784000000E+01,                00000250 

           -2.000000000E+00,+2.200000000E+01,                           00000260 

           2,2,                                                         00000270 

           -5.000000000E+01,+0.000000000E+00,+0.000000000E+00,          00000280 

           +0.000000000E+00,+2.160000000E+00,+4.128000000E+01,          00000290 

           +0.000000000E+00,-1.776356839E-15,-2.000000000E+00,          00000300 

           +0.000000000E+00,+2.400000000E+01,+0.000000000E+00           00000310 

$$ PartBody                                                             00000320 

CURVE000 = CURVE / 1,                                                   00000330 

           +0.000000000E+00,+1.000000000E+00,                           00000340 

           2,-5.000000000E+01,+0.000000000E+00,+4.000000000E+01,        00000350 

           +0.000000000E+00,+0.000000000E+00,+2.000000000E+01           00000360 

$$ PartBody                                                             00000370 

CONS0000 = CONS / SURF0000,CURVE000,+0.000000000E+00,+1.000000000E+00,  00000380 

           1,+0.000000000E+00,+1.000000000E+00,                         00000390 

           2,+3.440000000E+01,+0.000000000E+00,+0.000000000E+00,        00000400 

           +2.000000000E+01                                             00000410 

               :          :                                                 : 

$$  Solid Face.1                                                        00000720 

FACE0000 = FACE / SURF0000,1,                                           00000730 

           4,CONS0000,+0.000000000E+00,+1.000000000E+00,                00000740 

           CONS0001,+1.000000000E+00,+0.000000000E+00,                  00000750 

           CONS0002,+1.000000000E+00,+0.000000000E+00,                  00000760 

           CONS0003,+0.000000000E+00,+1.000000000E+00                   00000770 
               :          :                                                 : 

$$ PartBody                                                             00012580 

TOP00000 = TOP / 25,                                                    00012590 

           FACE0000,1,CONS0000,0,1,                                     00012600 

           FACE0001,1,CONS0006,0,1,0,                                   00012610 

           FACE0000,1,CONS0001,0,1,                                     00012620 

           FACE0002,1,CONS0010,0,1,0,                                   00012630 

               :          :                                                 : 

           FACE0008,1,CONS0039,0,1,0,                                   00013070 

           FACE0009,1,CONS0044,0,1,                                     00013080 

           FACE0010,1,CONS0047,0,1,0                                    00013090 

SET00000 = ENDSET                                                       00013100 

$$ No Identifier                                                        00013110 

GROUP000 = GROUP / 1,                                                   00013120 

           TOP00000                                                     00013130 

TCVDAFS  = END                                                          00013140 

        SUR19   , SUR22   , SUR15                                       00007840 

TCVDAFS = END                                                           00007850 
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 Geometrical Elements 
 

Point 
name = POINT/x,y,z 
 

 name Name of the Point 

 x,y,z Real coordinates of the point 

 Example P001=POINT/10.5,-10.,12.5 

 

Set of Points 
name = PSET/n,(n)*[x,y,z] 
 

 name Name of the Set of Points 

 n Number of points (n = integer value) 

 (n)*[x,y,z] For n points exactly n coordinates are to be specified. 

 Example PF001=PSET/2,5.,3.,0.,2.5,0.55,10. 

 

Point and Vector 
name = MDI/n,(n)*[x,y,z,vx,vy,vz] 
 

 name Name of the Point-Vector Set 

 n Number of sextuples (integer value) 

 (n)* [x, y, z, vx, vy, 
vz] 

For the n points exactly 3 n-times 3 coordinates and 3 vector-
components are to be specified  

 Example DI1=MDI/2,5.,3.,0.,1.3,9.2,1.,2.5,.5,1.,.9,1.2,1. 

 

Circle 
name = CIRCLE / x,y,z,r,vx,vy,vz,wx,wy,wz,a,b 
 

 name Name of the Circle 

 x,y,z Co ordinates of the circle center 

 vx,vy,vz Components of the orthogonal vector 

 wx,wy,wz Definition of circle level 

 a,b Start/end angle in degree 

 Example CIR1 = CIRCLE /1.0,1.0,1.4,1.0,-0.5,  
-0.5,0.7,0.7,-0.7,0.0,30.0,138.0 
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Curve 
name = CURVE/n,(n+1)*[par],(n)*[iord,(iord)*[ax], (iord)*[ay], [iord)*[az]] 
 

 name Name of the Curve  

 n Number of segments which form the curve 

 iord Relevant polynomial order of curve segments 

 par Global parameter values at start/end points of the segment 

 ax,ay,az Co efficient of current curve segment 

 Example See Example VDAFS File 

 

Surface 
name = SURF/nps,npt,((nps+1))*[pars],((npt+1))*[part] 

((nps*npt))*[iordu,iordv,((iordu*iordv))*[ax], 

((iordu*iordv))*[ay],((iordu*iordv))*[ax]] 
 

 name Name of the Surface  

 nps,npt Number of surface segments in u- and v-direction 

 iordu,iordv Polynomial order of the current surface segment in u- and v-direction. 

 pars,part Definition of surface segments in s- and t-direction 

 ax,ay,az Co efficient of the current surface segment 

 Example See Example VDAFS File 

 

Curve on Surface 
name = CONS / SURFNAME,CURVENAME,S1,S2,NP, (np=1))*[parp], (np)*[iordp, 

(iordp0*[as],(iordp)*[at]] 
 

 name Name of the Curve on Surface 

 surfname Element name SURF 

 curvename Element name CURVE 

 s1,s2 Global parameter values of the curve 

 np Number of curve segments for the two dimensional curve 

 iordp Relevant polynomial of curve segments 

 as,at Relevant co efficient of curve segments 

 parp Global parameter values of the two dimensional curve at the relevant start or end 
points of the segments 

 Example See Example VDAFS File 
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Limited Surface 
name = FACE / surfname,m,(m) * [n,(n)*[consname,w1,w2]] 
 

 name Name of the Limited Surface 

 surfname Element name SURF 

 consname Element name CONS 

 m Number of closed surface curve chains 

 n Number of CONS elements of a surface 
curve chain 

 w1,w2 Global parameter values of the surface curves which determine start and end value 
of a part of a CONS-element. 

 as,at Relevant to efficient of curve segments 

 parp Global parameter values of the two dimensional curve at the relevant start or 
finishing points of the segments 

 Example See Example VDAFS File 

 

Surface Union 
name = TOP/m,(m)*[(2)*[fsname,n,(n)* [consname,w1,w2]], icont] 
 

 name Name of the Surface union 

 fsname Name of an element SURF or an element FACE 

 consname Name of an element CONS 

 m Number of pairs of touching surfaces (pieces) (SURF/FACE) 

 n Number of CONS-elements of a surface curve chain 

 w1,w2 Global parameter values of the surface curves which determine start and end value 
of a part of a CONS-element. 

 icont Transition type (0=constant, 1-tangential  
constant, 2=tangential and curvature constant) 

 Example See Example VDAFS File 
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 Non-Geometrical Elements 

The following non-geometrical elements are supplied by the VDAFS exchange format. 

Header 
name = HEADER /n 
 

Mandatory entry at the beginning of the VDAFS file  

 name Name of the header 

 n 
(n > 19) 

Number of text lines which follow the initial line.  
Within the header no comment lines are allowed. 

 

Comment 
$$text 
 

 text Arbitrary text 
Each line that is to be used as comment line has to be marked by $$ in the first 
two columns. No comment lines are allowed within the begin code. Otherwise 
comments can be added anywhere. 

 

Structure 
name = BEGINSET; name = ENDSET 
 

 name Name of the Structure. The structure element is used to combine several elements 
to groups. This makes it possible to process individual data selectively. The 
assignment of one element to a group must be clearly possible. The names in 
BEGINSET and ENDSET must be identical. Each BEGINSET has to be followed by 
ENDSET as next structure order. The in boxing or overlapping of groups is not 
allowed. 

 

Group 
name = GROUP / n,(n)*[elementname] 
 

 name Name of the group 

 n Number of elements in the group 

 elementname Names of elements; allowed are:  
POINT, PSET, MDI, CIRCLE, CURVE, SURF, CONS, FACE, TOP, GROUP 

 

Transformation matrix 
name = TMAT / c11,c12,c13,c21,c22,c23,c31,c32,c33,c41, c42,c43 
 

 name Name of the Transformation Matrix 

 c11-c43 Coefficient of transformation matrix for 
rotation, shearing, scaling and translation.  
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Transformation l ist  
name = TLIST / tmatname,n,(n)*[elementname] 
 

 name Name of the Transformation List 

 n Number of elements in the transformation 
list 

 tmatname Name of the Transformation Matrix 

 elementname Names of elements 
Allowed elements are:  
POINT, PSET, MDI, CIRCLE, CURVE, SURF, CONS, FACE, TOP, GROUP 

 

End code 
name = END 
 

Mandatory entry, last line of the VDAFS file 

 name Name of the End Code; must correspond with name of the Begin Code. 
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3.3 VDAFS  PROCESSOR Parameters for CATIA V5 

3.3.1 General Parameters 

*DIRECTION_TO 
 

Signification: Transfer direction 

 CATIA Transfer direction VDAFS to CATIA 

 VDAFS Transfer direction CATIA to VDAFS 

 
3.3.2 CATIA-to-VDAFS Export 

3.3.2.1  General 

*CV_DLNAME_ALLOWED 
 

Signification: Selection of the document environment for selecting CATIA model files 

 0 (default) As document environment paths are used. 

 1 As document environment DL names are used. 

 

*CV_CATIA_FILE 
 

Signification: Path, name and extension of the CATPart to be converted to VDAFS 

 <name> Path, name and extension of the CATPart 

 

*CV_VDAFS_FILE 
 

Signification: Path, name and name extension of the target VDAFS file to be created from the 
specified CATPart. 
If the path name is not specified the file will be written in the current directory. 

 <name> Path, name and extension of the VDAFS file to be created  

 

*CV_LOG_FILE 
 

Signification: Path, name and extension of the log file 

 Default: .\vdafs.log in the current directory  

 

*CV_REPLACE_FILE 
 

Signification: Allow / not allow file replacing. 
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 OFF (default) If a file with the same name exists, it will not  be replaced. An error message will 
be displayed. 

 ON An existing file with the same name will be replaced. 

 

*CV_IDENTICAL_NAMES 
 

Signification: Adopt the name of the source file as name for the target file and the log file 

 OFF (default) The name will be adopted. 

 ON The name will be not  adopted. 

 
3.3.2.2  Header 

*CV_REC_COMPANY 

*CV_REC_DEPARTMENT 

*CV_SEND_COMPANY  

*CV_SEND_TOCONTACT 

*CV_SEND_ADDRESS 

*CV_SEND_FON 

*CV_SEND_PROJECTNAME 

*CV_SEND_OBJID 

*CV_SEND_VERSION 

*CV_SEND_CONFIDENTIALITY 

*CV_SEND_DATE 

 

Signification: Data for the VDAFS file header: 
Receiving company’s name, receiver’s name/department, sender’s company 
name, contact person in sender’s company, sender’s company address, sender 
telephone number, project name, object description number, variants, 
confidentiality, validity period. 

 <text> Respective text 

 
3.3.2.3  Elements 

*CV_POINT_ELEMENT 

*CV_LINE_ELEMENT  

*CV_CIRCLE_ELEMENT 

*CV_CURVE_ELEMENT  

*CV_SKETCH_ELEMENT 

*CV_PLANE_ELEMENT  

*CV_REF_PLANE_ELEMENT 

*CV_SURFACE_ELEMENT 

*CV_SOLID_ELEMENT 

*CV_LAYER_ELEMENT  

*CV_BODY_ELEMENT 

 

Signification: Allow to convert the elements (point, line, circle, curve, spline, plane, surface, 
solid, layer, body).  

 ON (default) The respective CATIA elements will be converted. 

 OFF The respective CATIA elements are not  converted. However, essential basis-
elements will be created. 
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*CV_PART_ELEMENT  
 

Signification: Export of CATParts, situated inside a CATProduct 

 ON CATParts will be converted.  

 OFF (default) CATParts will not  be converted.  

 

*CV_AXISSYSTEMS_ELEMENT 
 

Signification: Export of user defined axis systems 

 ON (default) User defined axis systems will be converted 

 OFF (default) User defined axis systems will be not converted 

 

*CV_CIRCLE_CONVERT_TO 
 

Signification: Form of the conversion of CIRCLE to VDAFS 

 0 (default) CIRCLE remains CIRCLE 

 1 Convert CIRCLE to CURVE 

 

*CV_SURFACE_CONVERT_TO 
 

Signification: Form of the conversion of SURFACE to VDAFS 

 0 (default) Convert to TOP 

 1 Convert to FACES 

 

*CV_SOLID_CONVERT_TO 
 

Signification: Form of the conversion of SOLID to VDAFS 

 0 (default) Convert to TOP 

 1 Convert to FACES 

 

*CV_LAYER_CONVERT_TO 
 

Signification: Form of the conversion of LAYER to VDAFS 

 0 (default) Convert to SET 

 1 Convert to GROUP 
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*CV_BODY_CONVERT_TO 
 

Signification: Form of the conversion of BODY to VDAFS 

 0 (default) Convert to SET 

 1 Convert to GROUP 

 
3.3.2.4  Options 

*CV_ABORT_ON_ERROR 
 

Signification: Error Reaction 

 OFF (default) If an error occurs, the VDAFS processing will be cont inued. 

 ON If an error occurs, the VDAFS processing will be interrupted . 

 

*CV_ALL_SHOW_NOSHOW_ELEMENTS 
 

Signification: Export of elements according to their visibility state 

 0 
Al l  elements will be exported—elements with shown as well as with h idden 
state. 

 1 Only the elements with shown state will be exported. 

 2 (default) Only the elements with shown state, that are real ly  v is ible , will be exported. 

 

*CV_ONLY_ELEMENTS_WITHOUT_CHILDREN  
 

Signification: Export of elements according to the existence of child elements 

 OFF 
Al l  elements will be exported—elements with child elements as well as elements 
that have no child elements. 

 ON (default) Only elements without child elements check box will be exported. 

 

*CV_ON_LAYER  
 

Signification: Export of elements according to their layer attribution 

 <string> If no layer is specified, a l l  layers will be included in the export.  
 

If layers are speci f ied , the export then will be restr icted  on the specified 
layers.  
(In the <string> will be included the layer numbers entered in the text box.) 

 



A P P E N D I X :  3 . 3   V D A F S  P R O C E S S O R  P A R A M E T E R S  F O R  C A T I A  V 5  

© TRANSCAT PLM GmbH 53 VDAFS PROCESSOR V1.10.x for CATIA V5 

*CV_IDENT_TAKEOVER 
 

Signification: Using CATIA identifiers as comments in the VDAFS-file 

 OFF CATIA identifiers are not  written as comments in the VDAFS-file. 

 ON (default) CATIA identifiers are writ ten  as comments in the VDAFS-file. 

 

*CV_GLOBAL_AXIS_SYS 
 

Signification: Selection of a reference axis system for the export 

 OFF The coordinates will be indicated relating to the local axis system 

 ON (default) The coordinates will be indicated relating to the global axis system 

 

*CV_APPROX_DEVIATION 
 

Signification: User defined approximation deviation. (This value is applied if the 
CV_APPROX_DEVIATION_USER parameter is set on ON.) 

 <double> Value of user defined approximation deviation. 

 

*CV_APPROX_DEVIATION_USER 
 

Signification: Using or not using user defined approximation deviation  

 OFF The user defined approximation deviation is not  used. 

 ON (default) The user defined approximation deviation is used. 

 

*CV_EXPORT_PRODUCT_US 
 

Signification: Export of a CATProduct into one or several VDAFS files 

 0 (default) A CATProduct will be exported with all its components into one only  VDAFS file. 

 1  
Every  component of a CATProduct will be exported into an indiv idual  VDAFS 
file. 
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3.3.3 VDAFS-to-CATIA Import 

3.3.3.1 General 

*VC_DLNAME_ALLOWED 
 

Signification: 
Selection of the document environment for saving imported models into CATIA 
model files 

 0 (default) As document environment paths are used. 

 1 As document environment DL names are used. 

 

*VC_VDAFS_FILE 
 

Signification: File name of the VDAFS file to be converted in a CATPart.  
If the path name is not specified, the file is created in the current directory. 

 <name> Name of the source VDAFS file 

 

*VC_CATIA_FILE 
 

Signification: Name and path of the CATPart to be created from the VDAFS file.  
If the path name is not specified, the file is created in the current directory. 

 <name> File name and path of the CATPart 

 

*VC_LOG_FILE 
 

Signification: Path, name and extension of the log file 

 Default: .\vdafs.log in the current directory  

 

*VC_REPLACE_FILE 
 

Signification: Allow / not allow file replacing. 

 OFF (default) If a CATIA-file with the same name already exists, it will not be replaced. An error 
message will be displayed. 

 ON An existing CATIA-file with the same name will be replaced. 

 

*VC_IDENTICAL_NAMES  
 

Signification: Adopt the name of the source file as name for the target file and the log file 

 OFF(default) The name will be not  adopted. 

 ON The name will be adopted. 
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3.3.3.2  Elements 

*VC_POINT_ELEMENT 

*VC_PSET_ELEMENT 

*VC_MDI_ELEMENT 

*VC_CIRCLE_ELEMENT 

*VC_CURVE_ELEMENT 

*VC_SURF_ELEMENT 

*VC_CONS_ELEMENT 

*VC_FACE_ELEMENT 

*VC_TOP_ELEMENT 

 

*VC_SET_ELEMENT 

*VC_GROUP_ELEMENT 

*VC_TMAT_ELEMENT 

*VC_TLIST_ELEMENT 
1 

 
 

Signification: Allow/not allow the conversion of elements (POINT, PSET, MDI, CIRCLE, CURVE, 
SURF, CONS, FACE, TOP, SET, GROUP; TMAT, TLIST  

1). 

 ON (default) The respective VDAFS elements will be converted. 

 OFF 
The respective VDAFS elements will be not converted. However essential basis-
elements will be created. 

 
1 These elements at present can not be activated, as these functions are not yet implemented —
these elements can not yet be imported into CATIA. 
 

*VC_PSET_CONVERT_TO 
 

Signification: Form of the conversion of VDAFS-PSET (set of points) 

 0 (default) All PSET elements from the VDAFS file will be converted to CATIA into points. 

 1 All PSET elements from the VDAFS file will be converted to CATIA into polygons. 

 2 All PSET elements from the VDAFS file will be converted to CATIA into lines, the 
lines being drawn from point to point. 

 3 All PSET elements from the VDAFS file will be converted to CATIA into splines. 

 

*VC_MDI_CONVERT_TO 
 

Signification: Form of the conversion of VDAFS-MDI – Point and Vector 

 0 (default)  Points All MDI elements from the VDAFS file will be converted to 
CATIA into points. 

 1 Points+Lines All MDI elements from the VDAFS file will be converted to 
CATIA into lines with their end points, the lines being drawn 
from point to point. 

 2 Lines All MDI elements from the VDAFS file will be converted to 
CATIA into lines, the lines being drawn from point to point. 

 3 Polygon All MDI elements from the VDAFS file will be converted to 
CATIA into polygons. 

 4 Spline All MDI elements from the VDAFS file will be converted to 
CATIA into splines. 

 5 Spline+Tangent All MDI elements from the VDAFS file will be converted to 
CATIA into splines, the vectors being used as tangents. 
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*VC_CONVERT_CURVES_TO_LINES 
 

Signification: Form of the conversion of VDAFS-Curve 

 OFF (default) Degree 1 curves in CATIA will remain curves. 

 ON Degree 1 curves in CATIA will be converted into lines. 

 

*VC_CONV_TOP_TO_SURF_IF_CLOSED  
 

Signification: Form of the conversion of TOP to VDAFS 

 0 (default)  Solid if closed Depending on which of these options is selected, c losed 
topologies will be exported in form of solids or surfaces. 
Open topologies in every case—irrespective of the 
selected option—will be exported as surfaces. 

 1  Surface if closed 

 

*VC_SET_CONVERT_TO 
 

Signification: Form of the conversion of VDAFS-SET 

 0 (default) Body From every VDAFS SET a body is generated, the elements of the SET 
being included in this body. 

 1 Layer All elements of a VDAFS SET will be transferred on an individual CATIA 
layer (elements of SET 1 on layer 0, elements of SET 2 on layer 2, and so 
on). 

 

*VC_GROUP_CONVERT_TO 
 

Signification: Form of the conversion of VDAFS-GROUP 

 0  Body From every VDAFS GROUP, a body is generated, the elements of the 
GROUP being included in this body. 

 1 (default) Layer All elements of a VDAFS GROUP will be transferred on an individual 
CATIA layer (elements of GROUP 1 on layer 0, elements of GROUP 2 on 
layer 2, and so on). 

 

*VC_POINT_COLOR 

*VC_PSET_COLOR 

*VC_MDI_COLOR 

*VC_CIRCLE_COLOR 

*VC_CURVE_COLOR 

*VC_SURF_COLOR 

*VC_CONS_COLOR 

*VC_FACE_COLOR 

*VC_TOP_COLOR 
 

Signification: Element colors 

 <integer> 
The color of each element is defined by an 4 bytes integer (red—bits 16-23, green 
—bits 8-15, blue—bits 0-7). 
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3.3.3.3  Options 

*VC_ABORT_ON_ERROR 
 

Signification: Error reaction 

 OFF (default) If an error occurs, the VDAFS conversion will be cont inued. 

 ON If an error occurs, the VDAFS conversion will be aborted. 

 

*VC_IGNORE_PARENT 
 

Signification: Conversion of parent elements 

 0 
Parent elements which were used to create other geometrical elements and which 
are no more needed will be not converted. 

 1 … will be converted in every case . 

 2 (default) … will be converted only  in error case . 

 

*VC_IDENT_TAKEOVER 
 

Signification: Use or not use VDAFS identifiers comments as CATIA feature names. 

 OFF New identifiers will be created 

 ON (default) VDAFS identifiers comments will be adopted as CATIA feature names. 

 

*VC_GLOBAL_AXIS_SYS 
 

Signification: Selection of a reference axis system for the export—not yet implemented. 

 OFF 
The coordinates will be indicated relating to the local axis system—option not 
yet implemented. 

 ON (default) 
The coordinates will be indicated relating to the global axis system—this option 
at present is the only available.  
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*VC_CURVE_CONNECT_SEGMENTS 
 

Description: Importing VDAFS-CURVE elements to CATIA with Merge or Break import mode 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 -1 Break import mode for all elements (option deactivated) 

 0 Merge import mode—if curve is C0-continuous; otherwise  Break import mode  

 1 Merge import mode—if curve is C1-continuous; otherwise  Break import mode  

 2 (default) Merge import mode—if curve is C2-continuous; otherwise  Break import mode  

 3  Merge import mode—independently of continuity 

 

*VC_CONS_CONNECT_SEGMENTS 
 

Description: Importing VDAFS-CONS elements to CATIA with Merge or Break import mode 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 -1 Break import mode for all elements (option deactivated) 

 0 Merge import mode—if curve is C0-continuous; otherwise  Break import mode  

 1 Merge import mode—if curve is C1-continuous; otherwise  Break import mode  

 2 (default) Merge import mode—if curve is C2-continuous; otherwise  Break import mode  

 3  Merge import mode—independently of continuity 

 

*VC_SURF_CONNECT_SEGMENTS 
 

Description: Importing VDAFS-SURF elements to CATIA with Merge or Break import mode 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 -1 Break import mode for all elements (option deactivated) 

 0 
Merge import mode—if surface is C0-continuous; otherwise  Break import 
mode  

 1 
Merge import mode—if surface is C1-continuous; otherwise  Break import 
mode  

 2 (default) 
Merge import mode—if surface is C2-continuous; otherwise  Break import 
mode  

 3  Merge import mode—independently of continuity 
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*VC_CURVE_CTR_PT_TOLERANCE 
 

Description: 
Tolerance of the control points for the continuity examination of the VDAFS-
CURVE elements to be imported to CATIA 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 <double> Default value: 0,001 

 

*VC_CONS_CTR_PT_TOLERANCE 
 

Description: 
Tolerance of the control points for the continuity examination of the VDAFS-
CONS elements to be imported to CATIA 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 <double> Default value: 0,001 

 

*VC_SURF_CTR_PT_TOLERANCE 
 

Description: 
Tolerance of the control points for the continuity examination of the VDAFS-SURF 
elements to be imported to CATIA 

 lockable This parameter can be locked by the administrator to prevent value modification 
by the user. 

 <double> Default value: 0,001 

 
* * * 



 

 

 

TRANSCAT PLM  in the Internet:  http://www.transcat-plm.com 

VDAFS in the Internet:  http://www.transcat-plm.com/tcsoft 

VDAFS  Hotline: 

 

Phone: +49 721 970 43   35 

E-mail: vdafs@transcat-plm.com 

© TRANSCAT  PLM GmbH, 2012   
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